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B2GNow 

B2GNow software (stands for Business to Government Now) is diversity management and 
compliance software that NDOT uses to process applications for DBE Certification, track 
certified DBEs, perform outreach, and monitor contract compliance. The software allows the 
prime contractor, subcontractors, NDOT Resident Engineers, crew office staff, and NDOT 
Contract Compliance to all view the same information about construction contracts. The 
software is web-based and is provided to contractors and subcontractors to use free of charge.  
 

How to Access B2GNow Software  
 
For access to B2GNow (to obtain a username and password) please contact Contract 

Compliance at (775) 888-7497 or email ContractComplianceProjects@dot.nv.gov.  New users 

will receive an email showing their username and temporary password. 

You will be required to update your password when you first sign on, following the password 

requirements below: 

 

 

B2GNow software can be accessed via the link on NDOT Sharepoint Application Launch Pad, 

or by typing https://ndot.dbesystem.com/ into your web browser.  It is recommended that you 

save the website in your favorites for easy access.   

Accessing B2GNow Via SharePoint 

Select “Application Launch Pad”, then click the “B2GNow Compliance and Certification Mgmt 

System” link in the “Adminstrative” section of the launch pad. 

mailto:ContractComplianceProjects@dot.nv.gov
https://ndot.dbesystem.com/
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The login screen appears (you need an internet connection – this is a web-based software 

system).  Enter your username and password.  Click the “Forgot Password” link on the sign-in 

page if you forgot your password. 

Configuring the Dashboard  

When you first log on, your Dashboard (or Home page) will be blank in the center of the page, 

and will show some items on the right side that appear on all Dashboards.   
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Configure your dashboard by clicking the “Personalize” link in the top right corner of the home 

screen. 

 

 

 

A list of options appears along the top of the screen.   

Showing a Summary of Contracts on the Dashboard 
 

To show all contracts you are authorized to view, select “Contract Summary”, then “for 
organization”, then “Add Item”. 
 

  

 

This adds an area to your dashboard where you can access all contracts by their status: 

 

Click the blue hyperlink to see the contract details.  Make sure you remove the checkbox “Show 

ONLY contracts assigned to you” to see the greatest number of contract details. 
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Contracts you are permitted to view will be listed.  Click on the blue “View” hyperlink to view the 

contract information. 
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Detailed information will be shown for the selected contract, displayed on multiple tabs. 

 

Showing Flagged Contracts on the Dashboard 
 

You can configure your dashboard to show the contracts you are currently working on, or any 

other contracts you have “flagged.”  This requires two things:  

1) The contract is flagged from the Contract Management screen by clicking “Add to 

Dashboard as Priority Flagged Contract” 

 

 

 
 

 



 
7 

Revised January 2017 

2) You add Priority Flagged Contracts to your dashboard 

a) From the “Home” tab, select “Personalize” in the top right corner 

b) Then select “Priority Flagged Contracts,” and “Add Item” 

 

 

 

 

 

 

You will see all flagged contracts listed in the “Priority Flagged Contracts” section of your 

Dashboard or Home page.  The blue hyperlink provides an easy quick-link to the contracts you 

have flagged. 
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All contracts are migrated into B2GNow within two weeks of the award date.  If you cannot 
access contracts you believe you should be able to access, please contact Contract 
Compliance at (775) 888-7497 or email ContractComplianceProjects@dot.nv.gov. 

 
Accessing Contract Information 
 

Contract information is accessed either by clicking on the hyperlink from your Dashboard (see 

“Configuring the Dashboard”) or by using the Contracts sub-menu option in the “View” menu. 

Expand the View menu by clicking on it.  
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Select the Contracts option… 

 

Uncheck the box “Show ONLY contracts assigned to you” 

 

A list of contracts will appear.  Select a contract by clicking on the “View” hyperlink in the first column next to the 

contract you wish to view. 
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The contract information is displayed on multiple tabs… 

 

 

Not all users will access all tabs in the Contract Management area.  If you need access to tabs 

that do not display, please contact Contract Compliance at (775) 888-7497 or email 

ContractComplianceProjects@dot.nv.gov. 

Subcontractors and Service Providers in B2GNow  
 
The firm wishing to subcontract or utilize a service provider adds the subcontractor/service 
provider in the “Subs” tab in B2GNow… 
 

 
 

mailto:ContractComplianceProjects@dot.nv.gov.


 
11 

Revised January 2017 

and completes the online form:
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The completed form can be viewed in the “Subs” tab by the Resident Engineer, Prime 

Contractor, Subcontractor/Service Provider, and Contract Compliance.  Select “View” from the 

right side of the screen next to the contractor’s name. 
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Approved and Pending Subcontractors and Service Providers can be viewed in the “Subs” tab 

in B2GNow. 
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Monitoring Goal Attainment by Dollar Amount 

This is the main data set in B2GNow that a Resident Engineer will use to monitor progress 
towards the DBE goal.  It is located on the Compliance Audit Summary tab of the Contract. If 
the For Credit to DBE Goal “Current Award” amount matches the “Payments” amount, the goal 
will be met. 

 

 
 

 
 

 
 

Use this screen to monitor progress of the contractor towards meeting the DBE goal.  The “For 
Credit to DBE Goal” row, “Current Award” column shows the dollar amount of DBE participation 
the contractor must either achieve or show good faith efforts to achieve by the end of the 
project.  The “For Credit to DBE Goal” row, “Payments” column shows the actual amount the 
contractor has paid to DBEs to date.  Use this amount to monitor attainment progress in 
comparison to the contractor’s DBE Utilization Plan submitted prior to the pre-construction 
conference and updated monthly. 
 
Refer to the NDOT DBE Program Plan for steps to take if the contractor is not meeting their 
goal, or is not likely to meet the goal by the end of the project. 
 

Monitoring Attainment with Amounts Subcontracted to DBEs 

The “Subs” tab of the Contract Management screen has a “Subcontractor Award Totals” 
section.  This section shows the amount and percentage of the total contract actually sublet to 
DBE subcontractors, versus the amount the prime committed to subcontract to DBEs.  This 
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information is useful to monitor progress of the prime contractor in utilizing the DBEs they 
committed to utilize in the amounts committed. 

If a contractor has not entered subcontracts with DBEs into B2GNow according to the utilization 
schedule they submitted that month, the Resident Engineer should follow up to find out why not. 

 

 

 

 

 

A contractor can only meet their DBE goal by paying subcontractors the amount committed to 
pay to DBEs.  If the contractor does not list DBEs in B2GNow in the amount of the commitment, 
they have no chance of meeting their stated commitment.  Follow up with contractors if you do 
not see a high enough dollar amount of DBE subcontracts in B2GNow.  Do this early and often, 
based upon the DBE Utilization Plan submitted by the contractor prior to the pre-construction 
conference and updated monthly.  

 
Understanding DBE Utilization Data in B2GNow 

B2GNow uses the term “For Credit” when describing a DBE or SBE subcontractor whose 
participation is being counted towards the DBE or SBE goal.  There are multiple goal and 
attainment percentages displayed throughout B2GNow, and it is imperative that you understand 
what each one represents. 
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Quick Reference – Understanding Percentages 

Contract header:  

 

Goal = Contractor’s Committed Participation (relative to awarded contract amount) 

% Credit = Amount paid to DBEs as a percentage of total payments to prime thus far 

Contract “View” tab, Contract Settings section 

 

Required Goal = advertised DBE goal 
Proposed/Committed Goal = total commitment at time of contract award 
Actual Goal = total commitment at present time 
 
Contract/Compliance Audit Summary tab 
 

 
For Credit Progress = total payments to DBEs as a percentage of total subcontracts awarded to 
DBEs 

Commitment Percentage  

In all tabs of the Contract Management screen you will see “Goal” and “% Credit” data.  The 
Goal in the header of the Contract screens is the percentage of the total contract that the 
contractor has committed to pay to DBEs – it is the Actual Goal (see Advertised, Committed, 
and Actual DBE Goal Percentages).  This percentage represents the total amount the 
contractor listed on their DBE Report submitted at bid time, plus any DBEs added or minus any 
DBEs removed (with NDOT’s approval and per 49 CFR 26), all as a percentage of the total 
contract amount. 
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In this example, the goal is 11.51%.  The prime contractor listed $9,552,130.54 of DBE 

participation on their DBE report at bid opening time.  The total contract award amount was 

$82,999,999, and therefore the contractor’s DBE commitment (in B2GNow this is called the 

“goal”) is 11.51%. 
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Please note that the goal of 11.51% is based upon the contractor’s commitment, and is different 
from the originally advertised DBE goal assigned by NDOT for the project.  In this example, the 
originally advertised goal was 7%. 

 

Advertised, Committed, and Actual DBE Goal Percentages 

Once a contractor makes a commitment, that commitment “%” is the most important percentage 
for Resident Engineers to monitor and contractors to attain.  It is a contractually obligated 
commitment.  However, it may be useful to see other percentages, including the originally 
advertised goal “%.”  For full details of all DBE goal percentages on a contract, from the 
“Contracts” tab select the contract number you wish to view.  Then select the “View” tab. 
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Scroll down near the bottom of the screen to the “Contract Settings” section.  Here you will see 

multiple DBE goal percentages. 

 

The required goal is the one set at advertising time.  The Proposed/Committed Goal is the 

amount the contractor originally listed on their DBE report at bid time.  The Actual Goal 

represents the current contractually-obligated DBE participation for the prime contractor – it is 

the originally listed DBE participation plus any added DBEs and minus any removed DBEs.   

 Attainment Percentages 

There are two different attainment percentages in B2GNow. 

 

1) Percentage of Total Paid to Prime Thus Far 

The amount the prime contractor has paid to DBE subcontractors is reflected as a percentage 
of the total amount NDOT has paid to the contractor thus far in the "% Credit” field of the 
contract header. 

 

2) Percentage of Total Dollars Committed to DBEs 

The amount the prime contractor has paid to DBE subcontractors is reflected as a percentage 
of the total amount committed to be paid to DBEs in the “For Credit Progress” field of the 
Compliance Audit Summary tab of the Contract.  NOTE:  If the “For Credit Progress” tab is not 
turned “on” for a DBE, the Prime will not receive credit for any payments to that DBE.  Contact 
Contract Compliance should you discover that the DBE is not getting credit for work performed 
as a DBE under the contract. 
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